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Disclaimer of warranty 
THIS SOFTWARE IS DISTRIBUTED "AS IS" AND WITHOUT WARRANTIES AS TO 

PERFORMANCE OR MERCHANTABILITY. THIS SOFTWARE IS DISTRIBUTED 

WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES WHATSOEVER. BECAUSE 

OF THE DIVERSITY OF CONDITIONS AND HARDWARE UNDER WHICH THIS 

SOFTWARE MAY BE USED, NO WARRANTY OF FITNESS FOR A PARTICULAR 

PURPOSE IS OFFERED. THE USER MUST ASSUME THE ENTIRE RISK OF USING 

THE SOFTWARE. 

 

Copyright notice 
Geccos (all versions) is copyright Pål Woje & pawosoft. It is freeware and can be copied and 

distributed freely as long as it is not changed or altered in any way, and provided that this 

documentation is included. It can under no circumstances be used commercially in any way without 

prior written agreement from its owner. 

The toolbar icons are downloaded from the web under GNU Lesser General Public License or created 

and/or moderated by the author. 

The unit graphics are either created by or Stefan Sheckells by the author. 

 

Generic Campaign Control System (Geccos) – Beta version 0.1.3.2 
This is a temporary user guide for the current beta version of Geccos. Please note that as this is a 

beta version, there will possible be some bugs. Also note that any campaigns you create using this 

version might be incompatible with later versions, but I will try very hard to avoid that!  
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Startup 
When you start the program, you get the following screen. This is the main window. 

 

You can resize and move this window to suit your taste and screen resolution. The program will 

remember your settings the next time you start it. 

At startup you can only create new campaigns or load existing campaigns, both found in the File 

menu. You can also load an existing campaign by clicking on the only available button on the toolbar. 

The other buttons will be made available when you load or create a campaign. 
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Create New Campaign 
To create a new campaign, select ‘Create new campaign...’ from the File menu. The following screen 

will appear. 

 

Campaign full name: The full name of the campaign. 

Campaign short name: The name of the folder and file under which this campaign will be saved.  

NB! Can only contain legal MS Windows folder-/file name characters. 

Campaign start date: This is the starting date for the campaign. To edit it simply click on an item (e.g. 

month) and use the numpad ‘+’ and ‘-‘ keys. You can also click on the dropdown arrow to select a 

date. To quickly jump to different time periods you can click on the heading (marked in red below) to 

quickly “zoom out”. Click repeatedly to get a broader selection. 
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Forces: The various forces or sides fighting in this campaign. Click on the Add button to add a force. 

Select a previously added force from the dropdown list and click on the Delete or Rename buttons to 

delete or rename it. 

Map: The map used in this campaign. Click on the Select map file button to select a map file (JPG, 

BMP or GIF format) to be used in this campaign. 

After you have completed the form, click on the Create the campaign button to create the campaign. 

A new folder with the same name as entered in the short name field will be created in the campaign 

folder (see below), the map file will be copied to it and the main campaign file will be saved as <short 

name>.xml. Created campaigns will be saved in a sub-folder called “campaigns” located under the 

Geccos install folder, e.g. “c:\program files\pawosoft\geccos\campaigns”.  When distributing a 

campaign, you should zip the entire folder containing your campaign. It should then be copied into 

the campaign folder on the receiving systems. 

If Geccos cannot find the map file in the same folder as the campaign file, the user will get the option 

to search for the map file manually. 
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Toolbar 
The Geccos toolbar contains often used functions. 

 

The buttons all have a help text that will pop up if you let the mouse pointer hover above them. Most 

(but not all) buttons also have a counterpart in the menus. 

From left to right, they are: 

Load existing campaign  

If you already have created a campaign or received it from someone else, you can load it clicking on 

the Load button. In addition you can select “Load existing campaign…” from the File menu. 

A standard Open file dialog box will open and enable you to select an existing campaign.  

Save  

This is will save the current campaign. It will overwrite the currently loaded file. In order to save it as 

a new campaign file, use “Save campaign as…” from the File menu (or press F12). 

Zooming   

After you have created or loaded a campaign, the main window will display the map maximum 

zoomed out. To zoom you can either use the “+” and “-“ buttons on the toolbar, or use the mouse 

scroll wheel. If you zoom in by using the scroll wheel, the map will zoom in on the location of the 

mouse pointer. 

Enlarge/shrink units   

You can use these buttons to change the size of units on the map. Alternatively, you can use the 

mouse scroll-wheel while holding down the CTRL-key on the keyboard. 
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Create units  

When clicking on this button, the following dialog box will appear: 

 

Give the unit a name and select a force it belongs to. The force dropdown list contains the forces you 

added when you created the campaign. Below this you select which symbol set to choose a unit 

image from. The list contains all the images you can select. Click on one to select it. The color buttons 

let you choose a foreground and background color for Allied, German WWII or Warsaw type images. 

The NATO symbol set is based on map symbols found in the FM 1-02 (FM 101-5-1) manual.  

The allied symbol set is handmade and loosely based on allied WWII/Korea style map symbols with 

some modern symbols. 

The German symbol set is a set of handmade symbols based on German WWII map symbols. 

The Warsaw symbol set a set of handmade symbols based on Warsaw Pact map symbols. 

The custom symbol set lets you browse for a graphic file (bmp, gif, jpg or png format) to use instead 

of one of the included icons. The file will be copied to a folder called “custom graphic” in the 

campaign folder. This must be included when you distribute your campaign, so you should follow the 
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guidelines on page 7 for this. You cannot change color of transparency when using custom images. 

New and previously added custom graphics will be listed in the list box. 

For allied/german/warsaw type units, you can also create a color scheme which you can then assign 

to units. The benefit is that if you later want to change the colors, you don’t have to update all units 

individually. You can simply update the assigned scheme. 

You can also create a force hierarchy by assigning a HQ unit to the unit you are creating. NB! You 

cannot create a loop, i.e. assigning a HQ that is also a subordinate further down the line. If you try to 

do this, you’ll get an information message. You can also clear the selected HQ. 

When you are satisfied with your selection, click on the Create & place button. The box will 

disappear, allowing you to click on the map to place the unit there. After placing the unit on the map, 

the box will reappear, allowing you to continue making units. Click on the Exit button to stop creating 

units. 
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Create labels  

When clicking on this button, the following dialog box will appear: 

 

Here you can enter the label text, select font (style, color, size etc), set whether the label will have a 

border and/or a background and what color the background will be. A preview of the label will be 

shown in the preview area. 

To place a label on the map, click on the “Place” button. You can now “stamp” the label as many 

times as you like on the map. The label window will not disappear. To place a new label, simply 

change whatever you want and click “Place” again. 
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Create Lines  

When clicking on this button, the following dialog box will appear: 

 

Here you can select whether to draw single lines or polygon lines, if a line is an arrow, the style, color 

thickness and transparency. A preview is shown in the preview area. When you are happy with your 

selection, click on the “Draw” button to start drawing on the map. 

How to draw is dependent on whether you are drawing single lines or polygon lines. When drawing 

single lines, left click on the map to place the line anchor point and then click again to place the end 

point. Repeat this process to draw more lines. When drawing polygon lines (lines with multiple 

segments), the process is a little different. Left click once to place the anchor point. Click again to 

place new legs. To stop drawing the current line, just right click anywhere. 

To draw another looking line, just change whatever you want in the dialog box and click on the 

“Draw” button again. 

NB! The line thickness will be set to whatever zoom level you are drawing on. E.g. if you draw a very 

thick line when zoomed all the way out, the line might fill the entire screen when zooming in. 



Geccos user guide 

 

13 

 

Create areas  

When clicking on this button, the following dialog box will appear: 

 

Here you select the type of area you want to draw, color, fill style, transparency etc. A preview is 

shown in the preview area. When you are happy with your selection, click on the “Draw” button to 

start drawing on the map. 

How to draw is dependent on whether you are drawing a polygon area or a rectangle or circle area. 

When drawing rectangle/circle areas, left click on the map and then, while holding down the mouse 

button, drag the mouse to draw the selected area. When drawing polygon areas (areas with multiple 

nodes), the process is a little different. Left click once to place the anchor point. Click again to place 

new points. The nodes will automatically be connected once you have placed at least three nodes. To 

stop drawing the current area, just right click anywhere. To start drawing another one, left click on 

the map again. 

To draw another looking area, just change whatever you want in the dialog box and click on the 

“Draw” button again. 
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View grid  

Click on this button to turn on/off the map-grid if it has been created (see ‘Set coordinate’ on page 

14). 

Overview map  

To see an overview map of the current campaign map, click on this button. A window as shown 

below will appear (contents will wary based on your selected map, of course).  

 

You can resize this window to suit your taste and screen resolution. When you zoom in or out the 

map in the main screen, a black rectangle will show which section on the map you are currently 

viewing. You can click on the overview map to center the view on the main screen there. 

Run movement simulation  

When you click on this button, a new toolbar is displayed near the bottom of the window, as shown 

below: 

 

Use this to simulate how units will move across the map using waypoints (see ‘Add waypoints’ on 

page 18).  
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Menu 
In addition to the toolbar, there are several functions in the menu not found in the toolbar. These are 

described below. Menu items which have a counterpart on the toolbar are skipped. 

File 

Save data file 

In addition to saving an entire campaign, you can save and load parts of the data as data files. These 

files are XML files, but named with a suffix based on type. That is, “.units” for files with unit data, 

“.labels” for files with labels data etc.  

To save a data file, select the appropriate option s from the File - Save data file menu. In addition, 

you can save all units which belong to a given side (force).  

These files can then be loaded using the Load data file option. When loading data files, new items 

(units, lines, labels etc.) will be added to the loaded campaign. Existing items found will be updated 

with the loaded information. 

Load data file 

Used for loading data files (see above). 

 

Edit 

Import custom unit graphics 

This function allows you to add custom graphic images you can then use to when creating units. 

When you select this, a standard open file dialogue box will open. Brows to the files you want to 

import, select them (you can select multiple files by holding down the Control key) and click on Open. 

Any files not already imported previously, will be copied to a folder called “custom graphic” in the 

current campaign folder. When distributing campaigns, it is important that this folder is included. 
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Create map grid 

This function let you create a grid on the map, just like on printed maps. Indeed, you can use this to 

duplicate the grids on scanned maps, making it easier to navigate, check ranges etc. 

To start creating a grid, you must left-click on the map where first grid point should be located. Then, 

while holding down the mouse button, drag the cursor to create a square. A rubber-band box will 

illustrate the size of the grid (highlighted in light blue below).  

 

When you are satisfied with the size of the square, release the mouse button and a new dialog box 

will appear where you can enter the grid values for the first grid as well as how many Km each grid 

side is, as shown below. 

 

The grid is now superimposed on the map, and you can easily see the grid coordinate in the status 

bar at the bottom of the screen when you move the cursor around.  

NB! If the map file used when creating the scenario is not properly aligned when scanned, the 

superimposed grid might deviate from the scanned one, as shown here: 
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Please note; you must create a map grid before you can use the range finding tools and the 

movement simulator. 

Adjust map grid 

If you discover that the grid you created is not entirely correct, you can either create it again from 

scratch (see above), or adjust it using this function. 

After selecting this function, you can use the num-pad arrows (2,4,6,8) to move the grid, and the 

num-pad + and – to increase/reduce the grid size (Num Lock must be on). De-select the function 

when you are satisfied. 

NB! If you accidentally use the regular arrow keys, the scrollbars will move instead. This will lock the 

mouse scroll wheel to the scroll bars (regular Windows feature) thus making it impossible to zoom 

the map with it. In order to reset this, zoom all the way out using the – button on the toolbar and 

then minimize and restore the window again. 

Create Range circles 

Range circles can be used to illustrate e.g. artillery range or communication range. You can create a 

set of range circles for the campaign and then assign them to units by right-clicking on the unit. 
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You can also edit existing range circles by selecting the “Edit existing” option below and then select 

one from the dropdown menu. 

        

The attributes you can use when creating range circles are similar to those used when creating areas 

as described in the Create Areas section of this document. When you have filled in the data for the 

circle you want to create, press the Create button. The circle will be added and the name text 

selected in order to show that you can create a new. 

 

To add one or more range circles to a unit, just right-click on it and select “Add range circle…” from 

the context menu. The following dialog box is displayed: 
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Select the chosen range circle from the dropdown. You can edit the default range if you wish. To 

remove range circles from a unit, right click on it and select “Remove last range circle” to remove the 

last added or “Remove all range circles…” to remove all. 

Set current date/time 

If you want to change the campaign’s current date/time, select this function. You will get a dialogue 

box as shown below. 

 

Here you can change the date and time as described in the ‘Create new campaign’ section on page 5. 

Delete all waypoints 

Select this for a quick way to delete all waypoints for all units. 

 

View 

Printed grid numbers 

When viewing the map grid you normally see the gridline numbers printed on the left and top side of 

the map as shown below. You can turn that function on and off here. 

 

Chain of Command lines 

When you select this function a thick blue line is drawn between units belonging to the same force 

hierarchy, e.g. from a HQ unit to its subordinate unit(s). Select again to turn off. 
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Single unit CoC lines on mouse-over 

This function will draw a thick line from the unit the mouse cursor is over to its HQ and/or 

subordinate units (if any). The line to the HQ unit is green, the others are blue. Select again to turn 

off. 

Units 

This function turns on/off the display of unit markers on the map (including areas, range circles etc.). 

Select to turn off and again to turn on. 

Areas 

This function turns on/off the display of areas drawn on the map (but not areas attached to units). 

Select to turn off and again to turn on. 

Lines 

This function turns on/off the display of lines drawn on the map. Select to turn off and again to turn 

on. 

Labels 

This function turns on/off the display of labels drawn on the map. Select to turn off and again to turn 

on. 

Range Circles 

This function turns on/off the display of unit range circles drawn on the map. Select to turn off and 

again to turn on. 

AO areas 

This function turns on/off the display of unit AO areas drawn on the map. Select to turn off and again 

to turn on. 

Tools 

Rangefinder 

Us this function to find the distance between two points. Left click on the map to set the anchor 

point. Then, while holding down the left mouse button, move the mouse to the point you want to 

find the distance to. The range is displayed in the status bar at the bottom of the screen. When you 

release the mouse button you can left click again to start over. 

Select it again from the tools menu to stop range finding. 
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Rangefinder path 

Find the distance along a path. Left click to set the anchor. Then left click to add legs to the path. The 

accumulated range will be displayed in the status bar at the bottom of the screen. To clear the 

current path, just right click on the map. 

Select the function again to stop range finding. Please note; you must have created a map grid in 

order to use this functionality. 

Lines 

Move line: When you have selected this you can click on a start/end point or a point between line 

segments. The point will be selected when you get a temporary line from the neighboring 

segment(s). Click again to place the line point. This option is active until you reselect it or select 

another tool. 

Delete line: Select this to delete entire lines or parts of a line. Click on a point on the line you want to 

delete. If the line just consists of two points, you are asked if you want to delete the line. If the line 

has multiple segments, you are asked if you just want to delete this point or the entire line. This 

option is active until you reselect it or select another tool. 

Waypoints 

Move unit waypoints: This works much like moving lines as described above, but on unit waypoints 

obviously. After moving a waypoint, the date/time for it and all subsequent waypoints are 

recalculated based on the new distance. 

Edit unit waypoint: When this is selected you can click on a waypoint and change speed/time data. 

Areas 

Delete area: click inside an area to delete it. 

Move poly-area nodes: click on a node on a polygon area to pick it up and move it. 

Move entire area: click inside an area then click on the map to move it there. For polygon areas the 

first node will be placed in the new spot. For the other two the center of the area will be placed 

there. 
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Using the program 
 

Unit handling 

There are several things you can do with units on the map. You can right-click on a unit to see its 

context menu. If there are several units in a stack, the context menu will list the names of the unit 

and you must first select one to see its context menu. NB! Not all choices may be available at all 

times.  

 

Move unit: select this then left click on the map to move the unit there. 

Bring to front/Send to back: move a unit up or down a virtual unit stack. 

Delete unit: delete this unit (NB! No undo, so use with care). 

Edit unit: edit a unit’s data. 

Edit unit image size: allow you to scale the image size of the units individually. 

Add waypoints: select this then left click on the map to put a waypoint there. A new window will pop 

up as shown below. Here you can decide the time span or the speed concerning the current 

waypoint. NB! Changing one will automatically update the other. 
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Repeatedly left click to add more waypoints. Right click when you are done. 

Delete last waypoint: delete the last waypoint for this unit. 

Delete all waypoints: delete all the waypoints for this unit. 

Add range circle: add a previously created range circle to this unit. Only visible if any range circles 

have been created. 

Delete last range circle: delete the last added range circle for this unit. 

Delete all range circles: delete all range circles added to this unit. 

Add attribute: <currently not completely implemented> 

Draw unit area: similar to Create Areas, but this area “sticks” to the unit, i.e. if you move the unit the 

area will move accordingly. 

AO rectangle: This menu will have one or more sub-menus based on whether the unit clicked on 

already have an AO area or not. 

 Add AO rectangle: similar to Create Areas, but here you enter the width and height of the 

area which will then be a rectangle centered on the unit. When you click OK in the dialog 

box, you set the angle of the area by clicking on the map. 

 Edit AO rectangle: update the look of the AO area (color, size, fill style etc.). 

 Delete AO rectangle: delete the unit’s AO area. 

 Set new angle: Let you change the angle of the AO area. 

You can resize the unit’s map icon by using the buttons on the toolbar, or by using the mouse scroll 

wheel while holding down the Control key. 

For Waypoint handling, please refer to the Tools section above. 
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Label handling 
If you right-click on a label you get a context menu. You can then edit the label, move it to a new 

location or delete it. 

When editing you get the same window, but with the current data filled in. Change whatever you 

want and click on the “Update” button. 

Label handling 
Please refer to the Tools menu section above. 

Area handling 
Please refer to the Tools menu section above. 

Known errors 
When right-clicking on a unit and not selecting an option from the context menu, the mouse pointer 

will not update data and toolbar selections when moving across the map afterwards. You can select a 

menu option or minimize/restore the program to fix this. 

When drawing waypoints the rubber-band line will not update correctly after entering a waypoint’s 

data. 

 


